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TAKE CONTROL

OF THE ANALYTICS,
DATA & NEWS

THAT IMPACT

YOUR PORTFOLIO

Bloomberg’s Portfolio & Risk Analytics
Solution helps portfolio managers achieve
their objectives by providing unmatched
transparency into their portfolio’s performance,
characteristics, risk and more.

From one location, a series of powerful,
integrated equity and fixed income tools deliver
consistent insight, enabling you to create and
execute differentiating investments strategies.
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INTRODUCIN
BLOOMBERG
PORTFOLIO &
RISK ANALYTICS

Understand your portfolio exposures, liquidity, stress testing, historical performance, forward looking risk, and much more.

PORT <GO> - POWERING YOUR PORTFOLIO At Bloomberg, we are committed to continuously adding
& RISK MANAGEMENT STRATEGIES greater clarity to your decision-making and to ensuring that
As a portfolio manager, your performance depends on you feel completely confident in these critical decisions.
various factors. You must manage and anticipate changes Our Portfolio & Risk Analytics solution is fully integrated

in complex markets every day, plan for every possibility, with the Bloomberg Professional® service—at no additional
and execute accordingly. You also need a flexible plan for fee—providing unparalleled access to the broad range of
responding to economic, financial, and political changes. sophisticated tools required by today’s asset managers.

The challenges have never been greater.

Bloomberg's Portfolio & Risk Analytics solution for
investment professionals empowers you to successfully
implement your portfolio investment and risk management
strategies. Our platform provides unmatched transparency
into your portfolio’s performance, characteristics,

risk structure, and more, helping you make informed
decisions for your Long/Short portfolios.

ACTIVE PORTFOLIO MANAGEMENT SOLUTION

PAST PRESENT FUTURE

» Backtesting » Real Time P&L » Tracking Error/Volatility

» Performance » Portfolio Benchmark » Value-at-Risk
Attribution Characteristics » Scenario Analysis

» Historical Performance » Trade Simulation » Forward Looking Risk

» Historical Risk » Portfolio Optimization
» News & Alerts
» Reporting
» Mobile Access

PORTFOLIO & RISK ANALYTICS // 03



Long/Short mode in PORT <GO> allows you to see Portfolio and Risk Analytics for Long/Short portfolios. You can see
analytics for the long book, the short book and the whole portfolio. Understand how your capital allocation decisions
and portfolio leverage contribute to your exposures and risks.

LONG/SHORT MODE IN PORT

» Create a new Long/Short view by selecting View » Make sure that your portfolios are loaded into
-> Create New View from the red toolbar and then Bloomberg, and then get started by selecting
choose Long/Short Default Settings option. You can a portfolio from the Port drop-down.

also enable Long/Short mode by selecting Settings
-> Long-Short Mode from the red toolbar.

» Set the Long/Short view as your default by selecting
View -> Set Current View as Default from the

red toolbar.
1D View - 1)) Actions - 13) Settings - 149 Trade Simulation - Portfolio & Risk Analytics
Characteristics Holdings Intraday Tracking Error/Volatility VaR Scenarios Performance Attribution
sl 555X - BBG EQu Vel Default (None)|ulVlBICS Sectors [x/MRtINUSD [ eyl o7/22/15 |al
O Date ® Trend
Name Wgt| Div Yld P/CFH P/B P/S P/E P/EBEst P/BElta Deltal
Adj Wat]
-‘ B BBLSX - BBG EQUITY LONG SHORT DEMO POR... 23.24 3.27 10.94 2.44 1.62 40.53 34.58 23.24
al Basic Materials 6.77 Ene 03 10.79 6.77
all Communic
all Consum 25.89
il View N MY_LONG_SHORT_VIEW 8 30.29
al iew Name MY_LONG_SHORT_VIEV 6 25.53
al . . . 22.47
. O New view with Long/Short Default Sett]g] 63
-' ® Copy from view BALANCED_VIEW =] 56
.
“ s e
PORT <GO> - Enable
Long/Short mode in PORT
by creating a new portfolio
view with Long/Short
Holdings as of: 1/13/2015 Submitted at: 14:38:55 ®¥ A 7Z0oom = L + defauh settings.
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ANALYZE YOUR
PORTFOLIO’S
HISTORICAL
PERFORMANCE

Bloomberg's Portfolio & Risk Analytics solution gives you the ability to analyze the historical performance of your
Long/Short portfolio. You can identify the sources of your portfolio’s return by sector, geographic region, a custom
classification, or even based on Bloomberg's multi-factor risk model.

HISTORICAL PERFORMANCE ANALYSIS

» Use the Performance Tab to examine the historical » Examine standard deviation, draw-down, Sharpe
cumulative performance of your portfolio. ratio and dozens of other commonly used risk/return
» Easily change the analysis time frame to hone in on measures under Statistical Summary sub-tab.
a specific sub-period or visualize long term » Gain insights into the drivers of historical risk
performance patterns. and performance.

5 e
Port BEu EQTY o ﬂ vs {;]‘\Dlt) B by EEEE
Unit Percentage
o Total Return % * Value

MBS EQTY_LONG. SHORT 37301 ¢ Track 2 wewme G, Zom

\ N / ‘V\ﬂ/
W, \Nl\q ﬂ F\/ W \ /V il om PORT <GO> - Performance
VA [\J '\/\ \Mf ‘J See how your portfolio has
T e e e e e SN i L) \ i e e e e | Ry performed over time. You can
! : supplement your holdings data
.»|  with transaction data to get
performance numbers that
more accurately match your
firm's data.
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PORTFOLIO PERFORMA
» Analyze your portfolio ﬁ b-i.‘
examining contribution u
short positions, or the wholg lic
y C

» Break down your portfolio b
region, or any other custom cIa ¢

377,356| 103,699 481,055 5,698,253| -3,547,352
B Consumer Discretionary 91,827 46,319! 138,145 485,501 23,328
all @ Consumer Staples 12.05 -39,287 46,563 7,276 617,758 -208,338
w | BEnergy 4.95 6,635 49,008 55,644 581,927 -383,911
il @ Financials 28.85 -27.83 535,549| -403,846, 131,703/ 2,457,234 -1,989,190
- B Health Care 11.42| -8.14| 3.28| -144,388| 126,219 -18,170 -26,661 -301,699
[ & B Industrials | 2.55 -4.57| -2.03| -16,013 216,634 200,621 -203,806| 49,853
|4l B@Information Technology 14.38| -11.19| 3.19| 4,679 11,7841 1646231 494,113 -532,942
" & Materials 6.05| -2.37| 3.68| -140,678 11,018 -129,660 738,181 -204,453
e B Telecommunication Services 5.71 5.71| 103,274 103,274 624,038|
al o Utilities 5.68 5.68 -24,241 | -24,241 -70,030|
PORT <GO> - Performance
Attribution
! ! ; Understand the sources of your
Holdings as of: Varies bz field Submitted at: 07/09/2015 +3* A Zoom -+

portfolio’s historical performance.

FACTOR-BASED PERFORMANCE ATTRIBUTION
» Explain portfolio performance in terms consistent with  » Decompose security returns into portions coming
your ex-ante risk management approach by leveraging from exposure to risk model factors, such as industry,

Bloomberg's multi-factor risk models which are fully country, style, currency, and from selection effect.
integrated with historical performance attribution.

[CXTEEE by

vs
Unit  Percenta

[l -74.55

[ B Consumer Discretionary -5.54

[l B Consumer Staples -7.14

N & Energy 6.15 -9.16

|4l BFinancials . 23.70 -27.79

. BHealth Care | 10.48 -6.70

|5 @ Industrials | 5.20 -4.32

(a4l BInformation Technology 14.04 -10.52

|17 o Materials 7.70 -2.95

[, o Telecommunication Services| 5.09 -0.42

[l @ Utilities 5.38

‘ PORT <GO> - Factor-Based

Attribution
Analyze the sources of your
portfolio’s historical performance

|l : ] | ) — based on Bloomberg's multi-factor

H N 1 i i . - W— .
Holdings as of: 12/31/2013 (1) 1 Notice Submitted at: 07/09/2015 +» A Zoom — + risk models.
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With PORT <GO> you can monitor the intraday performance of your portfolio in real-time, as well as quickly access the
news impacting your portfolio today. Inmediately identify today’s top and bottom return contributors. Keep track of your
portfolio’s performance even when you are out of the office by running Bloomberg Anywhere on your mobile device.

MONITOR FROM THE OFFICE

» Track how your portfolio is performing today and » Display the intraday cumulative return chart or heat
identify the sources of the return. map for a visual representation of today's activity.

» Quickly identify the top and bottom return contributors
for your portfolio by sector, by industry, or by any
other classification.

O )
Characteristics

a Top Holdings
port [FEHNGRMAGLE vs [ENOEEEE by [6EE
Unit  Basis Points EQ Prices Primary
’_’Name Ol Delta Adj Wgt
|

| Net” Long| Short] Net! Gross| Long|
" B BBG_EQTY_LONG_SHORT 53| 103.92| -92.43| 11.49| 196.35| 36.29| -
a B Consumer Discretionary 6 9.51| -6.69| 2.82] 16.20 52
al B Consumer Staples 5| 12.13| -10.13| 2.99] 23.26 2.75
a B Energy 4.06| -6.84| -2.79| 10.90| 4.87
all
£
a

B Financials 1 30.01 -29.71| 0.29| 59.72 27.01

]

5 333,148
B Health Care 5 13.93! -9.09| 4.84] 23.02] 111

2

8

13,644 -1 1
@ Industrials 2.45 -4.92| -2.47 7.37 1.06 13,102 2 ) 10,38 -
B Information Technology 14.09| -22.84| -8.75| 36.94| -4.54 =55 1 79,938 23,950
ik BlMaterigls 24 LN SIS 2 o 1 3T ) 8.88 _14.237 26,728 140 5

PORT <GO> - Intraday

. ! Performance

S e i e e = e ; | Monitor your portfolio’s intraday
performance relative to the prior
day's close prices.

I
Holdings as of: 5/15/2015
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» Access E
which is
global press re
» Apply alerts a

portfolios, ensuri M

research critical to you

PRESENT

BBG_EQTY_LONG_SHORT Cut-off §
1) BBG_EQTY_LONG_SHORT (All securities)
) News in Brief
) Wells Fargo Second Quarter Earnings Preview BRF 09:59
3) Camilla Donates Murray Wristband PAN 09:50
4) ANTM: $1,000 per dose drugs found "cost effective,” Bloomberg re -

\ : Chg -1.30

B Relative sector strenqth
) Macau names seeing notable strength following potential Macau ca F09:
%) Gaming & Leisure: Gaming and Leisure June Short Interest Report W SNR 09:19 o
EDWARDS LIFESCIE 30 %Chg +2.92%
u Bl 0934 .@E_

R BN 09:34
1) Northland Securities Upgrades Edwards Lifesciences to Outperform SPM 09:30+ || -

TEORE PORT <GO> - News Pop-up
: Instantly view the stories relating
to and impacting your portfolio
with Bloomberg News®.

Holdings as of: 5/15/2015 Zoom = ——ai—— + iR

MONITOR ON THE ROAD

QIDBLIIEL T a5
= eord Exuity inhoss ¢ +

TIEELEEEEE i rrr i rrr i i rrrrrrr

Monitor your portfolio’s intraday performance anytime and
anywhere on your Blackberry®, iPhone®, iPad® or Android

mobile device with Bloomberg Anywhere.

LELEETELEL T r i i i i r i i rrrrly
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EVALUATE YOUR
PORTFOLIO’S
CURRENT
STRUCTURE

Bloomberg's Portfolio & Risk Analytics solution centralizes the critical data and analytics you need to understand the
structure of your portfolios. Display the fundamental metrics you care about most, such as delta adjusted weights, beta
delta adjusted weights, P/E, and dividend yield. Create your own growth or trend metric leveraging Bloomberg's vast
fundamentals database.

AGGREGATE PORTFOLIO CHARACTERISTICS

» Analyze key characteristics of your portfolio on » Upload your own custom data and display alongside
a specific date or as a time series trend. Bloomberg data.
» Aggregate characteristics measures by any » Chart characteristics to see your portfolio exposures.

classification, such as sector, country, or any
custom scheme that you define.

...... : ettings - 19 Tra HEEIT I SR ~Portfolio & Risk Analytics
2 Cha r fo . ! r g : VaR Scenarios >z .
Summary Cash Flows Liguidity Risk

Port G_EQTY_LONzIREl (short) BNl GICS Sectors in [WEAE Feelllo 7/ 10/ 15 |m]
o Date ® Trend
ENS I Delta Adj Wgt | Beta Delta [ Div Yld l P/E I
| | | Adj wgt | |
T " Long Short!| Net! Gross Long! Short| Long| Short| Long ShortlL

4l @ BBG_EQTY_LONG_SHORT 97.71| -93.71 4.00 191.41 99.47 -92.98 3.73| 1.38 22.76 19.97S

4l BConsumer Discretionary 9.55| -6.79, 2.77| 16.34| 9.68| -5.39 4.29| 0.55| 19.79| 22.84 1

4l BConsumer Staples 13.29 -10.31 2.98 23.60 12.30 -9.92 2.83 1.16 25.61 28.682

i B Energy 3.97| -6.79 -2.82 10.76 4.67| -8.54 5.29| 1.82| 16.03| 20.69 2

4 BFinancials 23.14 -30.15| -7.00| 53.29 23.51 -29.75| 4.38 1.48 22.07 15.561

4l BHealth care 14.10| -9.19| 4.92| 23.29| 13.81 -9.37| 1.99 29.81| 26.1232

i B Industrials 2.49 -4.96 -2.47 7.45 2.70 -3.65 3.56 11.21| 31.38€

4l  BInformation Technology 14.31| -23.33| -9.02| 37.64 15.62 -23.42| 3.19 53.54| 27.43 7

& @ Materials 6.75 -2.20 4.55 894 9.11 -2.94 3.63 11.12| 13.525=

e B Telecommunication Services 4,23 4,23 4.23  4.64 7.66 22.18 £

i B Utilities 5.87 5.87 5.87 3.44 4.02 0 I S
PORT <GO> -
Characteristics Tab
Analyze the fundamental
characteristics of your portfolio

Holdings as of: 5/15/2015 Submitted at: 10:08:32 *3 A Zoom - ——1& —+m that matter the most.
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LIQUIDITY RI* \

» Understand your portfolio
average or total days}o
your positions.

PRESENT

. B Consumer Discr 100.
) . .. B Telecommunicat: 100.
5 . . 0.00| | mHealth Care | &
20 94.08| 0.00| 0.00 0.00: 0.00| | mEnergy | 100.
25 94.86 0.00| 0.00 0.00 0.00| | BMaterials I 94
130 95.60 0.00 0.00 0.00 0.00| | mConsumer Stapt: i
] B Financials ;
B Information Te{ 162.82
B Industrials 42.96
B Utilities (= 24.70|
3.20 o'
10 9.63 3.91 0.92 0.00 0.00 0.00
15 12.41 3.71 0.00| 0.00 0.00 0.00]
20 14.83  3.68 0.00  0.00 0.00  0.00 PORT <GO> - Liquidity Risk
= g;‘;; gﬁg gﬁ: g:% g:£ g:% Analyze your equity portfolio’s
lso | | | . structure in terms of the overall
TG s BREE SR 0 liquidity of your positions.
PORTFOLIO VALUE
(aka Capital or Net Asset Value, NAV)
» Let the system determine the portfolio’s value based » Input portfolio value manually in PRTU <GO>, or upload
on your holdings, or provide your own portfolio capital it daily as part of the holdings file.
or NAV.

Portfolio Display
Currency USD
Date L 07, = 12/31/13
Rebalanced General i =

Calendar Convention 05 Days (M-F)

® Enable Lot-Level Holdings

® Use Notional from SWPM/CDSW
Ticker Defaults

Inception Date 12/31/2013

e Price/Value at Inception usb

® Units at Inception

® Compute Historical Risk and Fundamentals data

Cash Defaults
u Enable Fixed Rate Return on Cash
Include Cash
Future Margin © Cash ® Pct
Short Margin o Cash ® Pct
Derivative Defaults
m Derivative Strategy & Share Private Deals
¥ Allow Sub-portfolios
Portfolio Value (Capital)
® Calculated [N L cverage 4
o Specified by User e i PRTU <GO> - Portfolio Value
- |  Customize portfolio value in PRTU
22 IR [T F— 1 06 or upload your portfolio value via
Last Update 07/13/2015 BBU <GO>.
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NDERSTAND
OUR
OR

TFOLIO’S
RISK

Bloomberg has developed fundamental risk factor models to help you measure and analyze portfolio risk through multiple
lenses, including volatility decomposition, stress testing, and VaR.

EX-ANTE VOLATILITY

» Discover fully transparent fundamental risk factor » See where the risk of your portfolio is coming from.
models that provide global, multi-asset class coverage Break down the sources of risk into country, industry,
across all of your positions. currency, style, greeks, factors, as well as idiosyncratic/

» Drill down into the portfolio’s underlying fundamental non-factor risk.
data for full risk data transparency—a Bloomberg » Embrace more informative risk decomposition using
exclusive feature. market standards and custom classifications.

B in [IE
X Horizon B
Portfolio Value 122,994,542.38 USD (51 name(s), 14% Gross MV) Portfolio Beta(ex-ante) 0.23 @
i Risk (Std) i Factor Risk (Std)
Ttem f Total Risk/ Factor | Non-Factor Country | Industry | Style
Long 10.94 10.37 3.48 10.67 1.75 2.26
Short 9.42 9.13 2.29 9.17 1.66 1.08
Net . 500 277 4.17 1,50 1.45 2.42
Click a number to see breakdown
Risk Contribution (%) T Factor Risk Contribution (%)

Ttem i Total Risk]/ Factor| Non-Factor| Country /| Industry Style
Long 100.00 89.87 10.13 89.08 -2.76 3.55
Short 100.00 94.09 5.91 92.25 1.20 0.65
Net 100.00 30.70 69.30 6.40 3.50 20.80
Tntfié Risk(Nert) Click chart bars to drill down © Risk e Exposure

44 : :

354 : : : PORT <GO> - Tracking
. 3 Error/Volatility
Pastn - = = - & s e | Analyze your portfolio's ex-ante

b e s Ee e (predicted) risk using one of
15 .
. r— —— Bloomberg's multi-factor
Country. Industry Style Non-Factor risk models.

PORTFOLIO & RISK ANALYTICS // 11



SCENARIO ANALYSIS
» Evaluate your portfolio using a variety o
scenarios, such as the global financia
or the debt ceiling crisis of 2011.

FUTURE

119,491,912

|Lehman Default - 2008 [ -3,502,630

@
© |Debt Ceiling Crisis & Downgrade in 20! -2,453,536 120,541,008

® |Greece Financial Crisis in 2010 -2,052,964/ -1.67 120,941,576

@ 0il Prices Drop - May 2010 -827,408 -.67 122,167,136 PrS
® |[Equities down 10% -714,572| -.58 122,279,976 .’

® [Japan Earthquake in Mar 2011 -398,212 -.32 122,596,328

© [EUR up 10% vs. USD -116,484/ -.09 122,878,064

@ Libya 0il Shock - Feb 2011 -4,189 .00 122,990,352

® [EUR down 10% vs. USD 116,484 .09 123,111,024

® Equities up 10% 714,572 .58 123,709,112

© |Russian Financial Crisis - 2008 ) : 918,979 : 7S : 123,913,520

¥ T i I 7 oo 1 I ] : I

PORT <GO> - Scenarios Tab
Stress test your portfolio and
identify sensitivities to selected
market risk factors.

CEEEEEEEE
§ Tod

VALUE-AT-RISK

» Get global multi-asset class security coverage, including » Discover Bloomberg's Monte Carlo, Historical, and
Stress Matrix Pricing on derivatives for more accurate Parametric VaR methods across multiple confidence
VaR forecasts. levels to calculate the maximum expected loss.

» Measure the VaR impact on proposed trades using » Employ robust proxy capabilities to assist in
Trade Simulation mode and portfolio optimization. exception handling.

Value 16,902,042 USD
VaR (P&L)

thodology

Monte Carlo Simulation VaR 620,045 769,334 988,738

Historical 1 Year Simulation VarR . 674,378 972,365 1,253,788
Historical 2 Year Simulation VaR 643,083 855,811 1,125,862
Historical 3 Year Simulation VaR 613,364 818,183 1,082,755
[Parametric VaR 638,925 761,326 903,644

Contributors

Portfolio 674,378 988,703

8 Industrials 87,3210 E5 { -3,754 112,863 0

B Financials 313,839 N -.90 | 1,177 445 615 I

B Utilities 144,387 a2 | -36,765 W 181,583 Il

B Consumer Discretionary 244,224 N 2.71 1 -36,113 322,284 N

B Telecommunication Services 106,863 .90 | -34,914 QI 132,101

o Materials 183,070 I 149 | -40,969 § 232,814 N

BHealth Care 239,558 [ 134 | -30,469 [ 318,683 I

@ Information Technology 342,870 -— 19.56 N -131,419 -I 478,149 -_ PORT <GO> - VaR Tab

BEnergy 145,177 -.25 16,399 192,091 o

B Consumer Staples 169,224 I 5 | -15481 | 224,635 Il Analyze the tail risk of your
portfolio using the latest risk
modeling techniques.

PORTFOLIO & RISK ANALYTICS // 12



Bloomberg's flagship application for portfolio analysis includes fully integrated portfolio construction tools. Trade
Simulation and Portfolio Optimization allow you to easily and rapidly identify trades that will ensure you make the
best investment decisions.

TEST THE IMPACT OF YOUR TRADE IDEAS
» Evaluate potential trades or edit existing positions » Analyze in real time the impact of hypothetical trades
using the Trade Simulation functionality. across the entire analytical suite of portfolio tools
available within PORT <GO>.

ation - Portfolic & Risk Analytics |
3/2015 / Optimizer Trades Add Holdings Save/Trade+ Settings &)
_Tracking Error/Volatil . "VaR _Scenarios  Holdings £+ -
5 sectors|zENMUSD [z As Of
o Date e Trend
Name [ntf:mulated[ Orig Wat] Wgt +/-| BuylSelll Delta Adj Wat
Wgt (%) %)
I I I I | "Long! Short|  Net| Grossl
4l 8 BBG_EQTY_LONG_SHORT 13.74 0.00 91.01 -78.25 13.74 169.25¢
4 @ Cash 0.00 0.98 0.98
Jll @ Consumer Discretionary 2.77 Q.00 9.57| -6.80 2.77 16.36¢
il 8 Consumer Staples 2.98 -0.98 648 -448 2,00 10.96%
& BROWN-FORMAN CORP-CLASS B 6.30 -3.57 -43,200.0{ 2.72 2.72 2.723
" COSTCO WHOLESALE CORP 5.29 -2.29-19,700.0{ 3.01 3.01 3.013
all CVS HEALTH CORP -7.23 4.10 46,900.00 -3.13 -3.13 3.13
E MONSTER BEVERAGE CORP =3.10 1.7515,800,00 =1.35| =1.35 1.35 3
all REYNOLDS AMERICAN INC 1.72 -0.97 -15,500.00 0.75 075 0.75¢
al B Energy -2.82 0.00 3,98 -0.80 -2.82| 10.779
.‘ B Financials =7.01 0.00 23.17| -30.19| -7.01| 53.36}
4l  BHealth care 4.92 0.00 14.12] -9.20| 4.92| 23.32] PORT <GO> -
v @ Industrials -2.47 0.00 2.50 -4.97 -2.47 7461 A =
Al B Information Technology 0.70 0.00 14.33| -13.62| 0.70| 27.95] Trade Simulation .
4 @Materials 4.55 0.00 6.75 -2.20 4.55 B8.95f Analyze how your portfolio's
B Telecommunication Services 4.24 0.00 4.24 4.24 4,244 Tati A
‘,‘ | utilities 5.88 0.00 5.88 5.88 5.88° CharaCterIStICS and rISk
structure would change
Turnover: 12.67% Zoom - i based on potential trades.

PORTFOLIO & RISK ANALYTICS // 13



» Upload your custom securit&

any other data as inputs to t p

Risk Model

7.00 9.00 11.00 13.00 15.00 17.00 19.00 21.00 23.00

Optimal Portfolios (Click row to view trades)

PORT <GO> - Optimization

Portfolio 4 17.5 2.93 0.98 Leverage PORT's built-in Portfolio

AL 2 = o Stﬁmd°;fgsuus Optimization capabilities to
construct your optimal portfolio.

IDENTIFY THE TRADES TO MEET YOUR INVESTMENT OBJECTIVES
» Easily identify the best set of trades that will give your » Analyze your hypothetical portfolio which incorporates
portfolio the exposures you want. these trades seamlessly into PORT <GO>.

Port BBG_EQTY_LONG_SHORT BmikNONE Risk Model
Trades

Showing Results for 3 -
Optimization Summary Status Success Goal Summa

15 Trade Value 18,449,300 Portfolio Total Risk
4 Vvalue of Buys 2,280,830 US Divyld
9 Value of Sells

usD

SALESFORCE.COM INC
MONSTER BEVERAGE CORP
ANADARKO PETROLEUM CORP
EDWARDS LIFESCIENCES CORP
SLM CORP

PORTFOLIO Turnover INIT_PORTFOLIO = PORT <GO> -
PORTFOLIO Abs(Short) Leverage  NONE 100 84.09 82.24 g
PORTFOLIO Long Leverage NONE 100 97.83 84.69 Optimizer Results
The Optimizer delivers suggested
trades for analysis with resulting
active total risk or any other
A Stored Results Y

optimization goal.

PORTFOLIO & RISK ANALYTICS // 14
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SEAMLESSLY
NTEGRATE

SECURELY UPLOAD YOUR PORTFOLIO
HOLDINGS FOR ANALYSIS IN PORT <GO>

Integration & Implementation

Upload your portfolio data in three ways to integrate your

portfolio holdings on the Bloomberg Professional service

to use for PORT <GO>.

» Manually enter or drag and drop your portfolio from a
file to the Portfolio Administration tool, PRTU <GO>

» Perform a manual one-time upload or schedule an
upload using the Bloomberg Upload tool, BBU <GO>

» Your portfolio data can be pre-integrated with the
Bloomberg Professional® service> providing turnkey
access to the portfolio analytics, news and alerts that
are crucial to managing your business smoothly and
efficiently through BBU <GO> via SFTP protocol.

Our team of portfolio integration specialists can help
you get started.

R POSITIONS
ANALYSIS

PAVE THE WAY FOR FIRM-WIDE
TRANSPARENCY & CONTROL

As an extension to the core portfolio analytics features
offered on the Bloomberg Professional service,

PORT <G O> analytics can be utilized across your
entire firm for a holistic view of your organization’s global
investment activities. Your senior management team—
from Risk Managers to the Chief Investment Officer—
can obtain unparalleled insight and transparency into
the firm's investments, resulting in a new and complete
level of confidence and protection for your organization.

2

) Documentation
Sample Files

3 Settings

Bloomberg Uploader

£ Prime broker

TION

I o

Where are you sourcing your data from?
0 In House System / Data Warehouse Name:
@ Third Party Data Provider Name:

£ And more

Client Contact Name:

I, -one:

Third Party Contact Name:

Tumkey portfolio

oN NE‘ integration with your:
/ Fund administrator
/ Custodian

/ Order management system

I -2

I -2

POR
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BOUT THE
LOOMBERG
ROFESSIONAL
ERVICE

The founding vision in 1982 was to create an information services, news and media
company that provides business and financial professionals with the tools and data they
need on a single all-inclusive platform. The success of Bloomberg is due to the constant
innovation of our products, unrivaled dedication to customer service and the unique way in
which we constantly adapt to an ever-changing marketplace. The Bloomberg Professional®
service is a powerful and flexible tool for financial professionals—whatever their needs—

in cash and derivatives markets as diverse as equities, currencies, commodities, money
markets, government and municipal securities, mortgages, indices, insurance, and legal
information. The Bloomberg Professional service seamlessly integrates the very best in
real-time data, news and analytics.
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In addition, Bloomberg users benefit from on-demand multimedia content, extensive
electronic trading capabilities and a superior communications platform. Bloomberg
customers include influential decision makers in finance, business and government.
Business and financial professionals recognize the Bloomberg Professional service
as the definitive tool for achieving their goals because it offers unparalleled assistance
and functionality on a single platform for a single price.

Real Service from Real People When You Need It.

Our 24/7 industry-leading customer service teams in

160 countries around the world will help you fully leverage
the analytics and data on the Bloomberg Professional service.
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